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Support. 
(1) Technical support, for technical support for all aspects of SAND and SCALE please email a 

marked up copy of the calculations in question to Dr Ian Brown ian@fitzroy.com. 

 

(2) Accounts, if you have changed address or if there is a new contact person, please email: 

Jeanette Brown, jeanette@fitzroy.com or post to Lark Lodge, Fornham St Martin, Bury St Edmunds, 

Suffolk IP31 1SR. 

 

Eurocodes. 
All proformas now show full calculations to the Eurocodes or full calculations to the British Standards, 

or are analytical and applicable to both codes. 

 

Windows 11. 
All programs in the SAND and SCALE suites are fully supported, tested and operational on all 32-bit 

and 64-bit desktop/laptop versions of Windows 11, Windows 10, Windows 8.1, Windows 8, 

Windows 7, Windows Vista and Windows XP Service Pack 3. 

 

Main changes to SCALE program in 2021 (Latest version is 6.14). 
The main items outlined in the last newsletter as plans for 2021 have been completed, namely: 

• Combined the GUI32 data editor so it appears in a resizable SCALE window. 

• Updated SCP for printing directly from SCALE 6 rather than the previous saving and printing of 

pdf files. End calcs are also displayed on screen directly from the .cal file. Removed the pdfviewer 

program which was used for displaying and printing pdf files, to enhance stability. 

• Added an NL-STRESS portal frame generator (proforma 820), with integrated wind and snow 

load generation. 

 

The major version number has been incremented to SCALE 6. Development of SCALE version 5 

started ten years ago, since when there have been 100 releases of SCALE 5. The move to version 6 

signifies that the incorporation of all the previously separate programs into one SCALE executable is 

now complete. The SCALE 6 executable contains SCALE, LUCID, SPADE, NL-STRESS, NL-PLOT, 

NL-VIEW (formerly 3D GUI), TAPE, and now from 2021 the NL-STRESS GUI and the SC600P32 

View Structure program. 

 

SCALE now has rounded bottom buttons to match the Windows 11 style, and also to not get cropped 

by Windows 11's rounded window borders! 
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SCALE available on the Apple App Store. 
SCALE is available on the Apple App Store. Monthly and annual in-app renewable subscription 

options are available. The SCALE app runs on all iPads with iOS 9.3 and above, i.e. on every iPad 

except the iPad 1 from 2010. The SCALE app includes the full versions of SCALE, LUCID, SPADE, 

NL-STRESS, NL-VIEW, NL-PLOT, and SCP (for creating pdfs). Click on the link on the fitzroy.com 

website, or search for “SCALE Structural Calculations” on the App Store. 
 

Plans for 2022. 
• Create training videos for all aspects of SCALE, LUCID, SPADE, NL-STRESS, NL-PLOT, 

NL-VIEW, TAPE, and the NL-STRESS GUI, and place them on the website. 

• Add zoom facilities to the viewing calcs screen at the end of the proforma. 

• There are still many intermediate files being saved to disk. Now that all of SCALE runs from one 

executable these files could be stored in memory to speed up the program, reduce conflict with 

antivirus checkers and cloud storage, and allow multiple copies of SCALE to run from one 

directory without clashes. 

• Extend the integrated TAPE editor so it appears for any diagram on any results page. 

• Combine the NL-STRESS GUI's steel section table selector so it's available from within the 

SCALE proformas. 

• Add European IP steel sections to the proformas. 

• Combine aspects of the NL-STRESS GUI with the NL-VIEW results viewer, so the user can easily 

make changes to the model and re-analyse on the fly. 

• Introduce new NL-STRESS commands to generate plots using NL-PLOT and possibly NL-VIEW. 

Currently plots are achieved by the NL-STRESS proformas using parametric commands, but these 

commands are hard to follow and are removed before viewing the file in the NL-STRESS GUI, so 

an alternative would be useful. 

• Introduce new NL-STRESS commands to replace the parametric sense= variable, as these are hard 

to follow and are removed before the viewing the file in the NL-STRESS GUI. (Notably: sense=2, 

include shear deformation; sense=3, ignore Professor Michael Horne's Q forces; sense=-3, ignore 

Q forces only if member is a cantilever; sense=7, use soft springs so NL-STRESS can compute 

the rotation of the member.) 

 

Installation. 

The 2022 update installs a new desktop shortcut named "SCALE 6" (to launch program scale.exe), for 

both SAND and SCALE licences. For new installations of SCALE 6, the installer now looks for 

previous versions of SCALE 5 and SCALE 4 shortcuts to get the previous installation and working 

directories. You can delete any existing shortcuts to SCALE 5, as the target is the same. 

 

As SCALE now includes all the NL-STRESS features that were previously only included in the SAND 

suite, there is no longer a separate front screen for SAND. 

 

SCALE version 6 retains the familiar scale ruler icon with a red stripe. The icon for SCALE version 4 

is the same scale ruler but with a blue stripe to differentiate between the old and new versions. 

 

SAND and SCALE version 4 are still included in the installation for users who are familiar with their 

interfaces. Any existing shortcuts you have to them remain unchanged, shortcuts to the previous 

versions can be created on new computers to the programs scale32.exe and sand32.exe respectively. 

Each front screen now includes a new button which will launch SCALE version 6 if required. 
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Changes to SCALE in 2021. 
• Added an initial line to the SCALE 6 menu: "Select this line to enter the proforma number directly" 

so you can jump straight in if you know the proforma number you want. 

• SCALE 6 printing now uses SCP to print directly to the printer, without creating a pdf first. Select 

the printer, page size and paper tray using the top menu option "File->Print Setup..." You can 

adjust the margins to find the best fit. You can change the aspect ratio: set negative margins to 

stretch the text outwards. Use print setup to adjust the graphics margins: to move the NL-PLOT, 

LUCID, SPADE output around the page if required. NL-PLOT plots and LUCID and SPADE 

drawings are always drawn to scale. Printing tested with Windows 11 to Windows XP, using laser, 

inkjet, networked, usb, pdf and parallel port printers. Right click on calcs and "Save as PDF File...", 

and "File->Convert a File to PDF..." work as before. 

• Revised the Files button operation so the treeview cannot be collapsed, as this could cause 

confusion. 

• The proforma 'flowchart' '/p' option has now been now extended with a new '/a' option. This 

embeds all sub-files into the file listing and also adds the line numbers to the file, this is useful 

when debugging proformas. 

• Number of allowable strings in a proforma doubled from 1000 to 2000 to fix problems with 

option 42 calling option 546. 

• Increased maximum proforma length from 32000 to 60000 lines to accommodate sc820.pro. 

• Fixed a file handle leak which caused SCALE to stop after saving 700 zero length pdf files within 

SCALE (when parametric checking finds bugs). 

• NL-VIEW has a new button to switch between STAGE 2 and STAGE 3 when three elastic 

NL-STRESS stages are present in the proforma, i.e. for sc820 and sc855. NL-VIEW STAGE 2 

and STAGE 3 screenshots saved to the calcs are built up as before, but now report STAGE 2 or 

STAGE 3 as appropriate at the top of the results page. For NL-VIEW STAGE 2 and STAGE 3, 

the initial sizing is based on the maximum values in both stages, use "settings" to change the 

scaling, all view settings are retained when switching between stages. 

• NL-VIEW now only shows toolbar buttons for FY FZ MY MZ as appropriate for the different 

analysis types. 

• NL-VIEW DS ANIM now resumes the animation when returning from settings and when 

switching between stages. 

• NL-VIEW DS ANIM toolbar button now hidden for plastic and sway analyses as it represents 

elastic loading only and would be misleading for non-linear behaviour. 

• NL-VIEW plane frame, initial view now starts in XY view. 

• Added long term concrete modulus calculations to NL-STRESS proformas. 

• Modified cchart.ndf and subr.ndf to fix a problem with creating concrete beam and column charts 

after an NL-STRESS analysis. 

• Fixed a bug with File->Copy File. 

• Fixed crash if saving a pdf with a missing NL-VIEW screenshot. 

• Removed an extraneous message for some NL-STRESS runs. 

• NL-STRESS error messages now start with a '###' as per SCALE error messages. 

• When 'Restarting' a named proforma file the screen is no longer blank. 

• Fixed reporting of several SCALE error messages if there is a problem with the proforma logic. 

• Reworded "Output" button to "Full Calcs"/"Condensed"/"Summary" for improved clarity, 

changed its shortcut to Ctrl+s. 

• Changed "Redo Stage" button shortcut to Ctrl+d.  
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User’s manuals. 
The User’s Manuals for SCALE, LUCID, SPADE, NL-STRESS, NL-VIEW, NL-PLOT are contained 

in the file scale.pdf. The help manual can be easily launched from the menu option Help->Help. 

 

Parametric checking of SCALE proformas. 
Proforma 42 parametric checking has been further enhanced, as part of Fitzroy's effort to reduce the 

likelihood of you encountering an error when running through a proforma. We are aiming to test all 

proformas with all possible input values. The parametric checking has been extended further in 2021 

with 72 new .prm files and 144 modified .prm files being developed. 

 

Proforma 42 now tells you what parameter tables are present to choose between. When run with option 

npat=15 zni=166 for 2490 sample stack files, the proforma now generates coverage plots for each 

variable against every other variable. For npat=15 zni=166, for variable type zty=1 the proforma now 

uses an algorithm to generate better coverage across the variable space. Where previously the scatter 

plots were straight lines, the points now cover the whole chart area. The proforma collates any ### 

error messages encountered into a text file, e.g. sc250.1.txt. The proforma collates all calcs, plots, error 

messages, the proforma and the parametric file into one pdf document, e.g. sc250.1.pdf, with a 

bookmark index, and with all the stack files as pdf attachments. (Collating the files requires 

the combinepdf.exe and pdftk.exe files (available from the download page) to be present in the 

installation directory, these files are not otherwise required for anything in SCALE.) 

 

Proforma 41 is a new proforma to automate running through proforma 42 multiple times. First save the 

parameter tables required in a .lst file - the included sc042.lst contains all parameter tables. Enter the 

filename when option 41 is run, or click on the Files button to select the file from a list. Intermediate 

files are saved into a subdirectory, e.g. 250.1 for proforma 250 table 1, such that multiple instances of 

SCALE option 41 can be run at once from the same directory. 

 

New proformas. 
sc820  new proforma: 3D Portal frame structure (2-10 bays) with optional 

haunches. Mono pitch, rectangular and gable roof frames can be 

considered with several vertical bracing options. End frames can 

either be moment frames or frame posts and simply supported 

rafters. The geometry, material properties and loading for the 

frame are input interactively. The proforma offers options for: 

wind loading assessment & unit loads assessment. Overhead 

travelling crane and/or mezzanine floor are also available user 

options. The proforma creates and runs an NL-STRESS data file, and 

then presents the results and plots of applied loading, bending 

moments, shear forces and deflected shape. 

sc854  Sway stability of braced frames. The proforma considers several 

braced frames for analysis taking into account second order effects 

using the "amplified moments method". The amplification factor is 

evaluated in STAGE 1 and then used in STAGE 2 to amplify the wind 

and equivalent horizontal forces. The space frame column bases and 

all other frame joints are assumed to be pinned throughout. 

sp461  End plate connection - beam to beam. This option details a beam 

with an end plate connected to a supporting column. 

sp462  Beam over column connection. This option details a beam over a 

column with an end plate at the head of the column. 

sp463  Crank beam over column connection. This option details a crank beam 

over a column with plates at the head of the column. 

sp464  Diagrammatic elevation of box frame. This option details a box 

frame in elevation. Use this proforma in conjunction with SPADE 

proformas 462 and 463 to produce details A & B. 
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Changes to SCALE proformas. 
In addition to the changes detailed above, we have made amendments to 215 proformas, the main 

changes are listed below: 
 

lu120,130,220,410,424,430,440,510,610,810,820  modified text relating to 

scale. 

lu460  initialise bar type for main bars to btm=72 before START, added 

bdi=16 default values to example. 

sc042  added ptype.  

sc073  added scenario IF nbars=1. 

sc089,094,095,097,134  replaced "concrete grade fck" with "cylinder 

strength fck". 

sc090  replaced "concrete grade fck" with "cylinder strength fck", moved 

default values from EC to before START, added scenario IF 

nbars<nbar. 

sc091,092  replaced "concrete grade fck" with "cylinder strength fck", 

added IF bichk=1 AND single=2 to replace IF bichk=1, added IF 

bichk=1 AND single=1 and scenario IF nbars<nbar, moved EC default 

values to before START. 

sc096  replaced "concrete grade fck" with "cylinder strength fck", renamed 

STEELF relating to EC with euSTEELF and retained STEELF relating to 

BS. 

sc098  replaced "concrete grade fck" with "cylinder strength fck", when 

iterations do not converge after 20 cycles a WARNING is now given. 

sc099  replaced "concrete grade fck" with "cylinder strength fck", set 

minimum cover=25. 

sc104  replaced "concrete grade fck" with "cylinder strength fck", added 

IF single=2 to SUMMARY. 

sc108  replaced Concrete grade with Char strength of concrete. 

sc117  added missing EDIT's, replaced Asv with area where appropriate, 

made str hidden where appropriate, enhanced DESIGN SUMMARY.  

sc134  added missing STOP command, repositioned text above EDIT, added 

date on line 1. 

sc151  defined gamc and gams before START command, updated chkrng for 

ans4. 

sc111  added several scenarios to proforma. 

sc118  removed EDIT /W 2 before $101, replaced ds with d. 

sc122  added IF ans7=1 to SUMMARY and +Ecs(i)=Ecs(1)  when ans9=1. 

sc134,151,153,155,157  replaced ‘concrete grade fck’ with ‘cylinder 

strength fck’ 

sc160  removed cover'=0 and cover=0 before IF ZZZZZ1=0, added scenario IF 

ratio<1. 

sc162  added scenario IF As2=0. 

sc164  added scenario IF b>3*a OR b<0.5*a. 

sc253  added missing plus sign to "factor". 

sc255  updated chkrng for ley' and lez'. 

sc256  pk1 now needs to be specified when scr=0, euK3 and eumois are now 

being used for both vari=1 & 2. 

sc269,275  added 1E-6 to several chkrng. 

sc275  added 1E-6 to chkrng for variable dc. 

sc286,288  enhanced diagrams. 

sc310  corrected selection of stype=1 and stype=2. 

sc350  added option to use hot finished circular hollow sections (CHS) 

only for both Rail and Post, updated CLASSp and CLASSr, added 

option to use SHS and RHS, added more text, added ec3sec.pro and 

ec3com.pro, made general enhancements. 

sc351  added scenario IF D<=2*edg. 

sc384,387,388  updated limiting slenderness to BS EN 1993-1-

4:2006+A2:2020. 
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sc385  added scenario IF selfc=1 before IF EXIST and set selfc=0, updated 

limiting slenderness to BS EN 1993-1-4:2006+A2:2020. 

sc386  replaced expression MybRd=Wply*fy/(gamM110^3) with 

MybRd=Wply*fy/(gamM1*10^3), added scenario IF mo>=1, removed 

variable name Lamo. 

sc390  replaced MyED with MyEd. 

sc391  replaced WARNING text VzEd kN > VplRd kN with VzEd kN > VplRd/2 kN. 

May 21 added flag=3 and flag=4, when flag=3 defined k1 & MEdy', 

when +flag=4 defined k1 & MEdz'. 

sc392  replaced ‘Minimum concrete grade’ with ‘Minimum grade of steel’. 

sc407  added missing expression L'=L*1000 needed for when simple=3. 

sc408  updated STORE 2.6 16 1 to STORE 2.6 17 1. 

sc410,411,414  extended to import NL-STRESS data and results from SPACE 

FRAME analyses, so they can be called by sc820. 

sc411  added scenarios IF NRESP=12 and IF prod=0. 

sc419  updated to show compressive strength classes as C20/25, C32/40, 

C25/30 and C40/50. 

sc422  made eufststf an internal routine, added FcRdf' and more screen 

display text, replaced FcRdbf with FcRdf, added references to SCI 

P398, added more text. 

sc423  removed scenario IF trow=2 THEN p2=p1 ENDIF as variable p2 is no 

longer used, added variable FcRdf', replaced FcRdbf with FcRdf, 

added references to SCI P398, set flmx=0 for EC, added more text. 

sc424  added FcRd, added more screen display text and modified expression 

for FcRd', added references to SCI P398. 

sc425  added FcRd', added more screen display text and modified expression 

for FcRd', added more text relating to tables and alpha chart, 

added references to SCI P398, set Leff=Leff1 etc. 

sc427  added references to SCI P398, added more text. 

sc429  added scenario IF mo>=1. 

sc437  updated STORE 2.6 16 1 to STORE 2.6 17 1, added IF stype=3 THEN 

h=od13 ENDIF & IF stype=6 THEN h=od16 ENDIF. 

sc440  extended to import NL-STRESS data and results from SPACE FRAME 

analyses, so can be called by sc820. Added scenario IF F=0 (BS 

option). 

sc441  updated SUMMARY, replaced Concrete grade with Compressive strength 

of concrete, added TABLE 1.3, replaced MEd=MyED with MEd=MyEd. 

sc445  extended to import NL-STRESS data and results from SPACE FRAME 

analyses, so can be called by sc820. 

sc453  added scenarios IF stype=3 THEN h=od13 ENDIF IF stype=6 THEN h=od16 

ENDIF, set Wplz=Wply and Welz=Wely when stype=3 or 6, added 

scenario IF MyEd>0 and set psi=0 when MyEd=0 is selected by user. 

sc457  added scenario IF psiM>M. 

sc458  modified Unity1 expression is now being used when NEd=0, added 

scenario IF NEd=0. 

sc460  the "sway-check method" only is used by this proforma, the 

"Amplified Moments Method" is no longer offered as an alternative 

method (BS option only), removed EHF's from STAGE 2 loading cases 

as PLASTIC method is used for the analysis, added load case 5 in 

STAGE 3, added further text, added variable name anscpi, added 

further loading cases to STAGE 2 when anscpi=2, added missing 

example default values. 

sc462  if no haunches present in steel frame portals, proforma now assumes 

1mm length of haunch instead (H=0 is only applicable for steel 

frames with a lattice rafter), replaced default value single=2 with 

single=1. 

sc465  added missing scenarios IF code=1. 

sc467  added scenario IF resPL=1, updated text. 

sc472  set ChiLT=1 when rest=1, removed (+=M) immediately after NL=1. 

sc480  added scenario IF beta1>1. 
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sc485  added references to P358. 

sc486  added variable FcRdf', replaced FcRdbf with FcRdf, added references 

to SCI P398, added more references to SCI P398, replaced IF 

Leff1>Leff THEN Leff=Leff1 ENDIF with IF Leffl>Leff THEN Leff=Leff1 

ENDIF, limiting value Leffl is now only reported if it governs for 

both code=1 and 2, added more text. 

sc487  added variable FcRdf', replaced FcRdbf with FcRdf, replaced example 

default values FcRd with FcRdf, added references to SCI P398, added 

more text. 

sc488,489  updated SUMMARY, replaced Concrete grade with Compressive 

strength of concrete. 

sc491  updated example default values (EC only), added references to SCI 

P398, added missing Patterns, added more text. 

sc492  made general changes to headings, added more scenarios relating to 

web bearing resistance, added buckling resistance check to 

compression cover plate, updated routines euvshr and euhshr. 

sc493  added further cond=1 relating to joint=3, added DIGITS 3, added  

*** Fail ***, added scenario IF theta1=theta2 AND theta1=90. 

sc494  added references to SCI P398, replaced [/10 with /10 at start of 

lines, added more text. 

sc495  renamed span of Tee section, added scenario IF ans3=1 AND L>6*d. 

sc512  added scenario IF Nid>0. 

sc515  added scenarios IF Mmd>0, IF Mid>0, IF Myy>0 and IF Mzz>0. 

sc521  updated chkrng for Md', Vd, Mu and Vu. 

sc525  replaced com1 with fecc. 

sc532  added 1E-6 to chkrng for t1, t2, den1 and den2. 

sc536  replaced chkkrng with chkrng. 

sc537  replaced 0.95d with 0.95*d, modified chkrng for variable name 

po(a). 

sc546  added scenarios IF ll1=0 THEN ll1=0.0001 ENDIF, IF ll2=0 THEN 

ll2=0.0001 ENDIF, IF ll3=0 THEN ll3=0.0001 ENDIF and IF ll4=0 THEN 

ll4=0.0001 ENDIF. 

sc548  added CS 454 Table 7.5.1a and more text. 

sc561  added minimum depth of box below gutter, updated chkrng for W. 

sc601  added scenario IF Iinc=0 THEN Iinc=0.01 ENDIF. 

sc602  added 31.5E6 kN/m² (Strength class C25/30 short term), added youngs 

routine to sc8000.pro, added sc8000.pro. 

sc602,606,664  added youngs routine to sc8000.pro, added sc8000.pro. 

sc640  updated proper routine with regards to E & G values, added 

reference to ‘Strength class C25/30 short term’. 

sc663  added units for angle THETA and scenario IF THETA>60. 

sc666  updated STORE 5 1 13 to STORE 5 1 14. 

sc688  added default e=10.5E6 kN/m² to example and added reference to 

Strength class C25/30 long term. 

sc701  removed eudr1 routine and updated EC drift=1 section. 

sc701a,702a,717a,820a,820c  new routine proformas called by the new ‘3D 

Space Frame’ proforma sc820. 

sc716  updated chkrng for nLpt, added missing plus sign to nLpt (EC 

option). 

sc742  added scenario IF cx=A. 

sc756  added scenario IF area<dist/10, added further text. 

sc757  revised chkrng for FVleft and FVrt. 

sc764  made reference to Strength class C25/30 short and long term, added 

further elastic modulus options, set mat=2. 

sc770  added chkrng 2+1E-6 1 Fs, removed surplus "." immediately after 

variable Fc. 

sc771  removed navigation symbols >> and >< relating to fast forward. 

sc775  program now uses soil angle of friction phi=0.01 when phi=0 is 

specified by user. 
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sc777  rounded E value, added scenarios IF fclass=4 and IF E>=31.5 AND 

E<=32. 

sc786  added WARNING and missing STOP command. 

sc794  when KPas=KAct L3=0 and A3=0, safety factor is set to 1.001 when 

SF1=1 is specified by the user. 

sc800  added fcd and further text, added references to C25/30 concrete 

strength class, redefined fck, added ltermE routine, EGvals is no 

longer used, added default values to example, replaced strength 

with compressive strength. 

sc801  replaced Grade 40 with strength class C25/30, added fck which is 

now used in subr.ndf, added ltermE and EGvals routines, added 

default values to example, added ‘compressive strength’ and 

scenario IF mt=1. 

sc802  removed lines after FINISH as this is a steel proforma only. 

sc803  added further elastic modulus options, added expression for modulus 

of rigidity, replaced strength with compressive strength, 

expression for constants replaced with CONSTANTS E e ALL G g ALL. 

sc808  added reference to Strength class C25/30 short term and Strength 

class C25/30 long term, modulus of rigidity is now evaluated by the 

program, EGVALr, EGVALb &EGVALc updated accordingly. 

sc809  modulus of rigidity is now evaluated by the program. 

sc810  added further elastic modulus options, replaced strength with 

compressive strength. 

sc820  new ‘3D Space Frame’ proforma. 

sc855  added gnotes routine, updated JOINT LOADS and loads on rafters, 

added more text and routine rhpro, added haunch length to diagram, 

amplification factor amp is now applied to horizontal loads only, 

added amp to STAGE 3 wind cases, added variable name anscpi, added 

further loading cases to STAGE 2 when anscpi=2. 

sc855b,855e,855d,855h,855l,855m  added gnotes routine, amplification 

factor amp is now applied to horizontal loads only, added amp to 

STAGE 3 wind cases, added variable name anscpi, added further 

loading cases to STAGE 2 when anscpi=2, added missing default 

values to example. 

sc555c,855f,855j,855k,855n  added gnotes routine, haunch properties are 

now evaluated automatically by program, replaced spro with SPRO, 

amplification factor amp is now applied to horizontal loads only, 

added amp to STAGE 3 wind cases, added variable name anscpi, added 

further loading cases to STAGE 2 when anscpi=2, added missing 

default values to example. 

sc856  added cchart.ndf, added ltermE and default values to Ex1 Option=4, 

added "compressive strength". 

sc862  redefined p7, p8, p9, p10 & p11 when tie=1,2 & 3. 

sc872  added DIGITS 4 for Option=3 & 4. 

sc876  added further elastic modulus options, removed expression g=E/2.6, 

replaced strength with compressive strength. 

sc877,879,892,924,983  added further elastic modulus options. 

sc878  added further elastic modulus options and expression for modulus of 

rigidity, made references to mat=2 only (concrete), removed 

references to nu. 

sc889  added fcd and references to C25/30 concrete strength class, 

redefined fck, added ltermE and default values to example, added 

"compressive strength". 

sc895  added text after command FINISH relating to the long-term elastic 

modulus of concrete and the use of expression EcLT=E/(1 + Φ). 

sc921  updated default values to example, replaced proratad with prorated. 

sc923  added further elastic modulus options, added matsel and expressions 

for modulus of rigidity. 

sc2000  updated to show compressive strength classes as C20/25, C32/40, 

C25/30 and C40/50. 
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sp202  replaced "drawing not to scale" with "drawing is not to scale", 

replaced bend with bcol, added bw to diagram, added further 

scenarios relating to ct=1, replaced IF ct=1 THEN +csw=cw with IF 

ct=1 THEN csw=cd, ccrs is now offered on screen when ct=1, updated 

offs expression with offs=(sbw-scsw), modified labels for column 

depth and width. 

sp416  added missing (1=Yes, 0=No) to tenstf. 

sp422  added missing (1 or 2) for bmnum selection. 

sp440  added missing (1 or 2) to parameter bmnum, removed word untorqued. 

updated proforma to draw correctly for the case when bmnim=2 and 

simla=1. 

sp442  added $10 & $11 before START. 

sp458  added $10 before START, added x1. 

sp460  added $10, $50, $60 before START, replaced $11 with Grade. 

sp492  added $10 before START, replaced $11 with Grade. 

sp510  added $10 before START, defined $11, $12, $13 before START. 

sp512  added $10 before START, defined $11, $12 before START. 

sp540,580  added $10 before START. 

sp550  added $10 before START, defined $20 before START. 

sp582  added $10 before START, added text before START for $20, $21, $30, 

$31, $32. 

sp590  added text before START for $15, $16, $20, $21, $22, added $10 

before START. 

sp592  added $99, $51, $53, $54, $55, $595 etc. above START, added IF 

strys<4 and IF strys=4 and more text, added missing commands 

required for two storey structure. 

sp605,608,610,612,613,614  added insulation between screed and slab, added 

text before START, updated diagrams. 

sp615  added wall types, added text before START. 

sp616,618  added $10 above START, added text above START, added insulation 

between screed and slab, added option to have id=0. 

sp619  added solid insulation between joists, added more text. 

sp620  added $10 above START, added text above START, replaced cip with ci 

where appropriate, added insulation between screed and slab, added 

option to have id=0. 

sp622,624  added $10 above START, added text above START, added insulation 

between screed and slab, added option to have id=0. 

sp630  added $10 above START, added text above START, added insulation 

between screed and slab, added more IF mem=0 scenarios, added more 

scenarios relating to dimensions, updated slabin. 

sp632  added $10 above START, added text above START, added insulation 

between screed and slab, added more IF mem=0 scenarios, added IF 

mem=1 scenario relating to dimensions, updated slabin. 

sp634  added insulation between screed and slab, added more IF mem=0 

scenarios, added IF mem=1 scenario relating to dimensions, updated 

slabin. 

 

 

 

Downloading updates during 2022. 
Further updates in 2022 will be posted to the download website at the beginning of April, July and 

October, please visit the download website for the latest version of 2022.EXE. 

 

Ian Brown 01/01/22 


